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Replacement Supplies
Purchasing Information
Purchasing Information

Where to Purchase
• Consult the dealer where you 

purchased your printer
• Consult an Oki Data Authorized Sales 

or Service Dealer. For the nearest 
dealer, call 1-800-654-3282.

• U.S., Puerto Rico, Guam, U.S. Virgin 
Islands only: Order on the Internet 
www.okidata.com.

• U.S. only: Order toll-free at 
1-800-654-3282, using VISA®, 
MasterCard® or AMEX®.

• Check office supply catalogs.

Part Numbers
Important!

Consumables designated “C9000 
Series” do not work with these 
printers. Use only Type C7 Toner 
Cartridges and Image Drums.

Toner Cartridges, Type C7 

Color OKI Part #
Black ..................................... 42918904
Cyan ...................................... 42918903
Magenta................................. 42918902
Yellow ................................... 42918901

C96_Toner.jpg
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Replacement Supplies
Purchasing Information
Image Drums, Type C7

Color OKI #
Black ..................................... 42918104
Cyan ...................................... 42918103
Magenta................................. 42918102
Yellow ................................... 42918101

Other Consumables

Consumable Oki #
Fuser ( )................... 42931701, 120V
                 ................... 42931702, 230V
Transfer Belt ( ).................. 42931601
Toner Waste Bottle ................ 42869401

C96_Drum.jpg

C96_Fuser.jpg
C96_belt.jpg
1f.tif, 2f.tif
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Replacement Supplies
Oki Services
Take Advantage of 
Oki’s Supply Manager!

• Calculates your usage based on 
information you provide.

• Sends you an E-mail when it’s time to 
reorder.

To register, go to www.okidata.com.

Check Out 
Oki Managed Services

A document output analysis of your 
business which could save you up to 
30% on your printing costs.

Call 1-888-654-6264 today to schedule 
an appointment with an Oki Managed 
Services project manager.

Or, for more information, go to 
www.okidata.com.
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Menu
Changing Settings
1. Press ENTER. 

2. Use the ∇   key to scroll down to the 
Function you wish to change.

3. Press ENTER.

4. Continue to use the ∇   and ENTER  
keys to drill down to the item you 
wish to change.

5. Use the ∇  key to move down to the 
setting you wish to engage.

6. Press ENTER.
An asterisk appears next to the 
setting.

7. Press ON LINE to exit the Menu 
mode.

C96_ReadyToPrint.jpg

C96_Functio
ns_Menu_a.
jpg
5



Menu

Menu
Structure
For more information, see the on-line 
User's Guide on the Documentation CD 
provided with your printer or at 
http://my.okidata.com.

– Configuration
• Page Count, Supplies Life.
• Network and System Settings.
• Size of paper automatically detected 

in feed tray.

– Print Information
• Printer & Network Configurations.
• Print Demo Page.
• Lists: HDD (hard disk drive) files, 

Fonts, etc.

– Print Secure Job (Password Protected)
Appears only if the optional Hard 
Disk Drive is installed.

• Print out confidential documents 
downloaded to the HDD.

– Menus
• Set the size, weight and type of media 

for the various feed trays.
• Adjust system settings.

– Admin Setup (Password Protected)
• Various Network Setups.
• Print Setup.
• PS and PCL Setups.
• IBM and Epson Setups.
• Color Setup.
• Memory and Flash Memory Setups.
• HDD and System Setups.
• Reset/Save/Restore Settings.

– Calibration
• Density adjustments.
• Registration.
• Color tuning.

– Print Statistics (Password Protected)
6



Paper (Media) Settings
Changing
Why Change?
Wrong media settings can cause:

• poor quality printing
• flaking
• damage the printer

Media Weight
The default media weight setting for all 
trays is AUTO.

Individual Print Jobs
If you are using special media for only 
one print job, you can adjust the media 
settings in the driver.  Load the media in 
the appropriate tray (usually the MP 
tray). In your application, click 
File → Print and adjust the media 
settings as necessary.

All Print Jobs (Defaults) 

1. Press ENTER.

2. ∇   key → Menus.  Press ENTER.

3. With Tray Configuration highlighted, 
press ENTER.

4. ∇  key → tray to be configured. 
Press ENTER.

5. Use the ∇  and ENTER to scroll 
through the submenus and to make 
your setting changes.

6. Press ON LINE to exit the Menu 
mode.

Control Panel 
Right Side.jpg
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Paper (Media) Settings
Changing
Reset to Factory Defaults 

1. Press ENTER.

2. Use the ∇   key to scroll down to 
Admin Setup. Press ENTER.
Enter Password appears.

3. Use the ∆ and ∇  keys to set the first 
digit in the password. Press ENTER.

Note:  The default Password is 0000.

4. Repeat the previous step until all four 
digits of the password are entered.

5. Press ENTER.

6. ∇  key → Settings. Press ENTER.

7. Highlight Reset Settings.  Press ENTER.

8. Press ENTER.
The printer resets and goes back to 
the Ready to Print state.

Control Panel 
Right Side.jpg
8



Paper (Media) Settings
Weight
US Bond
Select the appropriate settings in either the printer menu or in the printer driver.
Printer driver settings override printer menu settings. 

Setting US Bond (metric)

Auto (default) 17 to 57 lb. (64 to 216 g/m2)

Light 17 lb. (64 g/m2)

Medium Light 18 to 19 lb. (68 to 71 g/m2)

Medium 20 to 24 lb. (75 to 90 g/m2)

Medium Heavy 25 to 28 lb. (94 to 105 g/m2)

Heavy 29 to 34 lb. (109 to 128 g/m2)

Ultra heavy 1 35 to 50 lb. (132 to 188 g/m2)

Ultra heavy 2 51 to 58 lb. (192 to 218 g/m2)

Ultra heavy 3 [MP Tray only] 59 to 80 lb. (222 to 301g/m2)
9



Paper (Media) Settings
Weight
Index

Note:  To determine if a paper weight is US Bond or Index, check the metric 
equivalent. 

Example: 35 lb. US Bond = 132 g/m2; 35 lb. Index = 64 g/m2.
For more information, go to www.paper-paper.com/weight.html.

Setting Index (metric)

Auto (default) 35 to 118.6 lb. (64 to 216 g/m2)

Light 35 lb. (64 g/m2)

Medium Light 37 to 40 lb. (68 to 71 g/m2)

Medium 42 to 50 lb. (75 to 90 g/m2)

Medium Heavy 52 to 56 lb. (94 to 105 g/m2)

Heavy 60 to 71 lb. (109 to 128 g/m2)

Ultra heavy 1 73 to 104 lb. (132 to 188 g/m2)

Ultra heavy 2 106 to 141 lb. (192 to 218 g/m2)

Ultra heavy 3 [MP Tray only] 123 to 166 lb. (222 to 301 g/m2)
10



Paper (Media) Settings
by Paper Tray
Tray 1 

*Important!
� Duplex printing is restricted to paper only, 20 to 32 lb. US Bond.
� If you experience curling with 20 or 24 lb. paper, switch to 28 lb.

Media Weight 17 to 57 lb. US Bond (64 to 216 g/m2)

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)*

Media Size Paper:

• min. 4.1" x 5.8" (105 x 148 mm)
• max. 12" x 18" (305 x 457 mm)
• Custom sizes must be defined in driver before printing.

Transparencies: letter or A4

Takes 550 Sheets 20 lb. (75 g/m2) paper

200 transparencies
11



Paper (Media Settings)
by Paper Tray
Optional Trays
• Optional trays 2 and 3
• Optional 3-Tray High Capacity Feeder. 

Media Weight 17 to 57 lb. US Bond (64 to 216 g/m2)

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)

Media Size Paper:

• min. 5.8" x 8.3" (148 x 210 mm)
• max. 12" x 18" (305 x 457 mm)
• Custom sizes must be defined in driver before printing.

Each Tray Takes 550 Sheets 20 lb. (75 g/m2) paper

No transparencies 
12



Paper (Media Settings)
by Paper Tray
MP (Multi-Purpose) Tray
This is also known as the manual feed tray.  

Media Weight Paper: 17 to 80 lb. US Bond (64 to 301 g/m2), up to 166 lb. Index

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)

Banners: 20 to 34 lb. US Bond (75 to 128 g/m2)

Media Size Paper:

• min. 3" x 5" (76 x 127 mm)
• max. 12" x 18" (305 x 457 mm)
• Custom sizes must be defined in driver before printing.

Banners: up to 12" W x 47¼" L (305 mm x 1.2 m)

Transparencies: letter or A4

Takes 250 sheets 20 lb. US Bond (75 g/m2) paper

100 transparencies

25 envelopes

stack of label sheets approx. 1" (2.5 cm) high
13



Paper (Media) Settings
by Media Type
Paper

Sizea

a. Media type = Plain, Media weight = 17 to 57 lb. US Bond

Feed Tray, Exit Trayb

b. Face-Down = top exit tray (see page 28);
Face-Up = straight-through, side exit tray (see page 29)

Letter, Legal-13/13.5/14,  Executive, Tabloid, Tabloid 
Extra, A3, A3 Wide, A3 Nobi, A4, A5, B4, B5

All Trays,

Face-Down (up to 47 lb.) or 
Face-Up (up to 57 lb.)

A6 Tray 1 or MP Tray,
Face-Up only

Customc:  min. 4.1" x 5.8", max. 12" x 18"

c. Define in the printer driver before using.

Tray 1, Face-Up only

Customc: min. 5.8" x 8.3", max. 12" x 18" Trays 2 to 5, Face-Up only

Customc: min. 3"  x 5", max. 12" x 18"
Banners to 47¼", max. 34 lb. US Bond

MP Tray, Face-Up only
14



Paper (Media) Settings
by Media Type
Labels, Transparencies, Envelopes 

Media Media Size Media Typea

a. Media Weight = not applicable.

Feed Tray
Exit Trayb

b. Face-Down = top exit tray (see page 28);
Face-Up = straight-through, side exit tray (see page 29)

Labels Letter or A4 N.A.c

c. N.A. = not applicable.

MP Tray only

Face-Up only

Transparencies Letter or A4 Transparency Tray 1 or MP Tray

Face-Up only

Envelopes COM-10 Envelope N.A. MP Tray only

Face-Up only
15



Paper (Media) Settings
by Media Type
Thick Paper (Cards, Index, etc.)  

Sizea

a. Media type = Plain.

Media Weight, Index Feed Trayb

b. Thick paper: use the face-up exit (see page 29).

Letter, Legal-13, Legal-13.5, 
Legal-14, Executive, Tabloid, 
Tabloid Extra

up to 119 lb. Any Tray

A3, A3 Wide, A3 Nobi, A4, A5, B4, 
B5

up to 166 lb. MP Tray only

Customc: min. 4.1" x 5.8"

c.  Maximum 12" x 18". must be defined in driver before printing.

up to 119 lb. Tray 1

Customc: min. 5.8" x 8.3" up to 119 lb. Trays 2 to 5

Customc: min. 3" x 5" up to 166 lb. MP Tray

Banners up to 12" x 47¼" up to 71 lb. MP Tray
16



Paper (Media) Types
Recommended Media
Media Type Recommended

Paper Letter:
• OKI® Bright White, 32-lb. US Bond (see page 23)
• OKI Banner Paper, 70 lb., (see page 23)
• HammerMill® Laser Print Radiant, White, 24-lb. US Bond
• Xerox® 4024, 20-lb. US Bond

Tabloid/Tabloid Extra:
• OKI Bright White, 32-lb. US Bond (see page 23)
• HammerMill Laser Print Radiant, White, 24-lb. US Bond

Labels Letter: Avery® 5161; A4: Avery 7162, 7664, 7666

Transparencies Letter:
• OKI 52205701 (see page 23)
• 3M® CG3720

Envelopes COM-10: OKI 52206301, 52206302 (see page 23)

Thick Letter:
• OKI 52205601 series Card Stock (see page 23)
• Wausau Exact Index: 49108 (90-lb.) or  49508 (110-lb.)
17



Media Types
Paper
For more information, see page 14.

Do not use
• Heavily coated, glossy, or smooth 

paper
• Embossed, rough, or heavily textured 

paper
• Recycled paper
• Paper with cutouts, perforations, or 

excessive paper dust.

Sample Ream Label

1 Media Weight, US Bond

2 Media Weight, Metric

1

2

ReamLabel1.bmp
18



Media Types
Labels
For more information, see page 15.

Caution!
Use labels designated for laser printers.

Labels must cover the entire carrier 
sheet. The adhesive must not be 
exposed.

Individual Print Jobs
Select the following settings in the 
driver:
• Source = MP Tray
• Size = Letter long, Letter short, A4 

Long edge, A4 Short edge
• Type = Labels
• Media Size = Off: Windows® Adobe® 

PostScript® only:
Windows XP / 2000

Printing Preferences → Advanced 
→ Document Options → Printer 

Features

Windows Me/98/95
Properties → Setup tab → Paper 
Feed Options

All Print Jobs (Make 
Labels the Default)

Set the printer menu:

Press ENTER to switch to the Menu 
mode.

Menus → Tray Configuration → MP Tray 
Config → 
• Paper Size → Choose Letter Long Edge, 

Letter Short Edge, A4 Long Edge, or A4 
Short Edge

• Media Type → Labels
• Media Weight → Choose Heavy, Ultra 

Heavy1, Ultra Heavy2, or Ultra Heavy3 (see 
page 9).
19



Media Types
Transparencies
For more information, see page 15

Caution!
Avoid office transparencies designed for 
use by hand with marker pens. These 
will melt in the fuser and cause damage.

Individual Print Jobs
Select the following settings in the 
driver:
• Source = Tray 1 or MP Tray
• Size = Letter  long, Letter short, A4 

Long edge, A4 Short edge
• Type = Transparency
• Media Size = Off: Windows® Adobe® 

PostScript® only (see page 19).

All Print Jobs (Make 
Transparencies the 
Default)

Set the printer menu:

Press ENTER to switch to the Menu 
mode.

For Tray 1
Menus → Tray Configuration → Tray1 
Config → Media Type → Transparency.

For MP Tray
Menus → Tray Configuration → MPTray 
Config → 

• Paper Size → Choose Letter Long Edge, 
Letter Short Edge, A4 Long Edge, or A4 
Short Edge

• Media Type → Transparency
20



Media Types
Envelopes
For more information, see page 15

Important!
For the best print results, use only the 
recommended envelopes (see page 
17).

Never use envelopes with metal 
clasps, snaps, windows, or V-flap 
seals: 

Individual Print Jobs
Select the following settings in the 
driver:
• Source = MP Tray
• Size = COM-10

All Print Jobs (Make 
Envelopes the Default)

Set the printer menu:

Press ENTER to switch to the Menu 
mode.

Menus → Tray Configuration → MPTray 
Config → Paper Size → COM-10 
Envelope.Envelopes.jpg
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Media Types
Thick Paper
For more information, see page 16

Caution!
To prevent damage to the printer, it is 
very important to check the printer’s 
media settings before printing on thick 
paper.

Individual Print Jobs
Select the following settings in the 
driver:
• Media Type = Medium Heavy, Heavy, 

Ultra Heavy 1, Ultra Heavy 2, or Ultra 
Heavy 3.

Note: See page 10 for more information 
on weight designations.

All Print Jobs: (Make Thick 
Paper the Default)

Set the printer menu:

Press ENTER to switch to the Menu 
mode.

Tray 1, 2, 3, 4, or 5
Menus → Tray Configuration →
TrayZ Config → Media Weight →
Choose Medium Heavy, Heavy, Ultra Heavy1 
or Ultra Heavy2.

MP Tray
Menus → Tray Configuration →
MPTray Config → Media Weight →
Choose Medium Heavy, Heavy, Ultra Heavy, 
Ultra Heavy2, or Ultra Heavy3.
22
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To purchase Oki Media, contact your 
local Oki dealer or visit www.okidata.com.

Bright White Proofing Paper
� 32-lb. US Bond 

Banner Paper*†

� 70 lb. Text, white, 12.9" x 35.4"
� P/N 52206001, Box of 100

SynFlex™*†

� Waterproof, Tear Resistant 
� White, 8½" x 11"
� P/N 52205901, Box of 100

Premium Color Transparencies
� Letter Size
� P/N 52205701, Box of 50

Premium Envelopes*†

� COM-10
� Security tint, Redi-Strip seal
� P/N 52206301, Box of 100       

Premium Card Stock*†

� Acid-free, white, 8½" x 11"  

* For best print results:
Temperature = 65 to 77°F
Humidity = 40 to 65% RH

† MP Tray only

Oki Part # Size Qty

52206101 8½ x 11'' 500/pack

52206102 11 x 17'' 500/pack

52206103 12 x 18'' 500/pack

Oki Part # Weight Qty

52205601 60-lb. Cover 250/box

52205602 90-lb. Index 250/box

52205603 110-lb. Index 250/box

Media Types
Oki Print Media



Loading Print Media
Trays 1-5
For more information, see the on-line 
User's Guide on the Documentation CD 
provided with your printer or at
 http://my.okidata.com.

1

2

3 Print side down:

Note: For Letterhead stationery:

Long edge feed—face 
down, top toward the 
back of the printer.

Short edge feed—
face down, top to 
the right:

C96_RearPaperStopper.jpg

fan_paper_F2_10.jpg

C96_LoadPape
rTray1_rev.jpg

Letr_lef.bmp

ltrhjd_se.bmp
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Loading Print Media
MP Tray
For more information, see the on-line 
User's Guide on the Documentation CD 
provided with your printer or at 
http://my.okidata.com.)

1

2

3

4 Print side up.

C96_OpenM
PTray1.jpg

C96_Ope
nMPTray2
.jpg

fan_paper_F2_10.jpg

C96_LoadPaper
MPTray.jpg
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Loading Print Media
MP Tray
Note: Letterhead Stationery (Letter, A4 
or B5):

Long edge feed—aim top toward 
the back of the printer:

Short edge feed—aim the top into 
the printer:

Note: Transparencies & Labels:

• Print side up.
• Default = long edge feed.

Envelopes:
• Flap side down, aimed into the 

printer:

manl_le.jpg

manl_se.jpg

C96_LoadP
aperMPTray
_Labels_cro
p.jpg

C96_Load
PaperMPTr
ay_Envelo
pels_crop.j
pg
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Loading Print Media
Changing the MP Tray Default
Check the Media Size
Default = Letter Long Edge

1. Press ENTER.

2. ∇  key →  Menus.  Press ENTER.

3. Highlight Tray Configuration.  Press 
ENTER.

4. ∇  key → MPTray  Config. Press 
ENTER.

5. ∇  key → Paper Size.  Press ENTER.

6. ∇  key → appropriate size (labels 
and transparencies:  select Letter or 
A4). Press ENTER.

7. Set the Media Type (transparencies) 
or Media Weight (labels, etc.), as 
described below.

Set Media Type: Transparencies

1. ∇  key → Media Type. Press ENTER.

2. ∇  key → Transparency.  Press ENTER.

3. Press ON LINE to exit the Menu mode.

Set Media Weight: Labels, Thick 
Paper, etc.

1. ∇  key → Media Weight. Press ENTER.

2. ∇  key → appropriate media weight 
(see page 9). Press ENTER.

3. Press ON LINE to exit the Menu mode.
27



Exit Paths
Face Down (Top)
This is the tray that is normally used.

The tray holds up to 500 sheets of 20-lb. 
(75 g/m2) paper.

The Face-Up exit tray (see next page) 
must be used for special media or for 
heavy papers.

C96_FaceDownExit.jpg
28



Exit Paths
Face Up (Side)
The side (face-up) exit tray provides a 
straight-through print path.  Use the 
straight-through path when printing, 
transparencies, labels, heavy card stock, 
or any printing from the MP Tray. It 
holds up to 250 sheets of 20-lb. 
(75 g/m2) paper. 

Opening the Face-Up Exit Tray

1

2

3

C96_StraightThruStackerOpen1.jpg

C96_StraightThruStackerOpen2.jpg

C96_Straight
ThruStacker
Open3.jpg
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First the document is assigned a 
password and processed to a print file 
which is saved on the hard disk drive (see 
the on-line User's Guide on the 
Documentation CD provided with your 
printer or at http://my.okidata.com.)

To print the document, you must go to 
the printer and enter a password. 

To Print the Document
1. Press ENTER.

2. ∇  key → Print Secure Job. Press 
ENTER.

3. Use the ∆ and ∇  keys to scroll to the 
number for the first digit in your 
password. Press ENTER.

4. Repeat the previous step for each 
digit in the password.

5. Press ENTER.

6. Highlight Print. Press ENTER.

7. Use the ∇  key to enter the value for 
Set Collating Amount. Press ENTER.
Secure Print: The document prints.  It 
is deleted from the HDD.

Store to HDD: The document prints. 
It remains stored until you delete it.

8. The printer goes on line.

To Delete the Document
1. Follow steps 1 through 5 above.

2. ∇  key → Delete. Press ENTER.
3. Select Yes to confirm the deletion.

4. Press ENTER.
The printer goes on line.

Secure Print & Store to Hard Disk Drive



Control Panel
Keys
ShUT DOWN/RESTART

Hold down for more than four (4) 
seconds for a soft shutdown.

You can either restart the printer or turn it 
off:

• Restart: press the button again.
• Turn off: use the on/off (power) 

switch.

Back
Press to go back to the previous item or 
category.

Up Arrow (∆)
Press to go to the previous category or 
item in the menu.

Down Arrow (∇)
Press to enter the menu mode, or to go to 
the next category or item in the menu.

control_panel_no_callouts.jpg control_panel_no_callouts.jpg
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Control Panel
Keys
Enter
Press to engage the menu item shown 
on the display. An Asterisk (*) 
appears next to the selected item.

ON LINE

Press to save any menu changes and 
place the printer back on-line (Ready 
to Print).

CANCEL
Press to cancel the current print job.

HELP
Press to provide additional 
instructions for the error condition 
which appears on the display.

control_panel_no_callouts.jpg
32
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Ready

On
The printer is on line.

Off
The printer is off line.

Flashing
The printer is receiving data.

Attention

On
Warning!
The printer needs attention, but will 
continue to operate. An error message 
displays:  TONER LOW, PAPER NEAR END, 
etc.

Off
Normal.

Flashing
Alarm!
The printer needs attention immediately. 
An error message displays:  PAPER JAM, 
TRAY1 EMPTY, etc.

control_panel_no_callouts.jpg

Control Panel
Lights
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Power Save sets how long the printer 
waits before going into standby mode 
(default = 60 min). This saves energy, but 
the printer requires time to warm up 
when it receives a print job or if you want 
to enter the menu and change settings.

Set the Time Interval 

1. Press ENTER.

2. Use the ∇  key to scroll down to 
Menus.  Press ENTER.

3. ∇  key → System Adjust. Press 
ENTER.

4. Highlight Power Save Time. Press 
ENTER.

5. ∇  key → select the time interval.  
Press ENTER.

6. Press ON LINE to save the setting and 
exit the Menu mode.

Disable Power Save
1. Turn off the printer.

2. Press and hold ENTER while turning 
on the printer. Press and hold until 
Initializing displays.
The printer enters the Boot menu.

3. ∇  key → Power Setup. Press ENTER.

4. ∇  key → Power Save. Press ENTER.

5. ∇  key → Disable. Press ENTER.

6. Press ON LINE to save the setting and 
exit the Menu mode.

Control 
Panel RIght 
Side

Power Save
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You need to clean the LED head(s)
• when you install a new toner cartridge.
• if the printed sheets show signs of 

faded images, white stripes, or blurred 
letters.

1 Open the top cover about half way. 
This allows access to the LED heads 
without the guards in the way.

2 Use the lens cleaner supplied with 
the toner cartridges (or a clean, soft 
cloth) to gently clean the LED heads 
(1).

3 Close the cover.

C96_
Clean
_LEDs
1_CR
OP.jpg

C96_Clean_LEDs2_CROP.jpg
C96_Clean_LEDs3_CROP.jpg

Cleaning the LED Heads
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Printing Reports

1. Press ENTER.

2. ∇  key → Print Information. Press 
ENTER.

3. ∇  key → report you wish to print:

• Configuration: general information on 
your printer’s configuration, plus a 
listing of the current menu settings.

• Network: choose either a single-page 
summary printout, or a multi-page 
detailed list of network information.

• Demo Page: prints the Demo page.
• File List: files stored on the printer’s 

hard disk drive.

• PS Font List: PostScript fonts in the 
printer.

• PCL Font List: PCL fonts in the printer.
• IBM PPR Font List: IBM ProPrinter 

emulation fonts in the printer.
• Epson FX Font List: Epson FX 

emulation fonts in the printer.
• etc. (for more information, see the 

on-line User's Guide on the 
Documentation CD provided with 
your printer or at 
http://my.okidata.com.)

4. Press ENTER.
The report prints and the printer goes 
back on line.

Control Panel 
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Your printer has a built-in help system.

When an error message appears on the 
display,  press HELP.  The display shows 
information that will help you correct the 
error.

Use the ∇  key to move down through the 
Help information.

For more information, see the on-line 
User's Guide on the Documentation CD 
provided with your printer or at 
http://my.okidata.com.

C96_Help.jpg
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If you are experiencing frequent paper 
jams, check the following items.

• Is the printer level?
• Is the media you are using within 

specification (see pages 9 through 17)? 
Media that is too light or too heavy will 
often cause jams.

• Are the settings (printer and driver) 
appropriate for the media being 
used(see pages 9 through 16)? 

• Do not used creased or curled media.
• Remove the media from the tray.  Fan 

and align the stack.  Replace the media.

• Envelopes are jamming.  Make sure the 
stack is properly aligned. Load 
envelopes flap down, top edge toward 
the printer.   

• Clean the feed rollers: for more 
information, see the on-line User's 
Guide on the Documentation CD 
provided with your printer or at 
http://my.okidata.com.
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Available 24 Hours a Day, 
7 Days a Week

• Visit our multilingual web site 
www.okidata.com

• Visit

• Call 1-800-654-3282.

myokidata.jpg
Service and Support
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OKI is a registered trademark of Oki Electric Industry Company, Ltd. 

3M is a trademark or registered trademark of 3M.

Adobe, and PostScript are trademarks of Adobe Systems, Inc. which may be registered in 
certain jurisdictions.

AMEX is a registered trademark of American Express Co.

HammerMill is a registered trademark of HammerMill.

MasterCard is a registered trademark of MasterCard International, Inc.

Xerox is a trademark of Xerox Corporation.

VISA is a registered trademark of Visa.

Wausau Exact is a registered trademark of Wausau-Mosinee Paper Corp.
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